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FAQ’s – Actuarial Examination 

General: 

1. I have passed ACET. What do I do next? 

If you have passed the ACET, this means you are eligible for student membership of the 
IAI. Click on the following link to fill the Online Admission related details Click Here  

2. Where can I find more information on the syllabus? 
Syllabus may be obtained from Institute’s website – Click Here  

3. How many subjects can I attempt in one examination cycle? 
There is no limit; students can register for multiple exams in an exam session provided 

they do not fall on same date and time. 

4. What are the dates of actuarial exams? 
Actuarial exams are conducted twice a year – usually May and November. Examination 

dates for the upcoming exams are posted on the Institute website - Click Here for further 

details. 

5. Where can I appear for an exam? 
Institute has taken the initiative of conducting home based online Actuarial exams May 

2024 onwards. 

6. Do the answer scripts accrue negative marking? 
No, there is no negative marking. 

7. What is the pattern of the examinations - is it objective or subjective? 
For CB1, CB2, and Paper A of subjects CS and CM, 40% of the content shall be objective 

questions (MCQs), while for other subjects, the papers may include a mix of both objective 

and subjective components. Past examination papers and solutions are available on the 

Institute’s website - Check Here 

8. How do I prepare myself for the exams – is there a provision for coaching at 
IAI? 
Institute has a robust mechanism for coaching and counselling our students. Click Here 

to view the details related to coaching. 

9. I am not sure what order of sitting the exams to follow? 
While there is no prescribed order, it is seen that starting the actuarial exams with Core 

principles works well in easing the students’ understanding and logical follow through with 

the exam rigour.  A general thumb rule based on trends indicates that students follow a 

numerical order.  It may be worth noting that: 

CB1 – Business Finance assumes knowledge of CM1 

CS2 – Actuarial Statistics assumes knowledge of CS1 

CM2 – Financial Engineering and Loss reserving assumes knowledge of CS1, CS2, CM1 

and CB2. 

 

You may find it convenient to leverage your college education while selecting the 

subjects appropriately. Typically preferred choices based on education background have 

been: 

https://www.actuariesindia.org/admission-details
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/syllabus-0
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/examination_dates_examination
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/question-paper-solutions
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/node/3345
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Mathematics/Engineering: CM1 

Statistics: CS1 and CS2 

Economic: CB2 

Accounts / Commerce: CB1 

 

Whilst planning your exams, kindly note that there is no compulsory order of studying 

Core principle subjects. 

The numbering of the Core principle subjects represents an ordering that would be 

appropriate for anyone working in life insurance or pensions. Anyone working in general 

insurance may prefer to take CS2 at any stage after studying CM1 while someone working 

in investment may prefer to take CB2 and CM2 before CS2 and CM1. 

10. How much time does it take to prepare for a particular exam? 
This is a highly subjective question and solely depends on the student’s commitment. 

Nevertheless, the ball park hours of intensive study as reported by successful students in 

the past are as highlighted:- 

• Core principle subjects (CS1 & 2, CM1 & 2, CB1 & 2):Between 125 and 150 hours and 
student’s past educational background in the subject. 

• Business awareness (CB3) At least 20 hours plus two-day practical course 
• Actuarial Practice (CP1) 400 hours 
• Model Practice (CP2) 50 hours 
• Communication Practice (CP3) 50 hours 
• Specialist principle subjects (SP) 200 hours 
• Specialist applications subjects (SA) 300 hours 

 

11. What is considered as prior knowledge during CP2/CP3 examination? 
In CP2/CP3, it is assumed that the students have prior knowledge of CS, CM and CB 

subjects. 

Any additional information not part of assumed knowledge of prior subjects will be 

provided within the question paper itself, if relevant and applicable. 

12. Can I appear for CP1 in the beginning? 
There is no minimum eligibility for CP1. However, students may find it logically convenient 

to clear all core principle subjects prior attempting CP1. 

13. What is the eligibility for applying for CP2 & CP3 subjects? 
There are no pre-requisites of clearing other papers in order to register for CP2 & CP3. 

14. Is it mandatory to pass Paper A and Paper B individually for subjects CS1, CS2, 
CM1, CM2, CP1 and CP2? 
It is not mandatory to pass Paper A and Paper B individually. Kindly refer the Pass Mark 

Rule. 

15. Can I use an External Calculator from approved list of IAI during online 
examination? 

 Yes, you may use scientific calculators during the examination as applicable. However, 

only the following models are permitted: 

https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/sites/default/files/inline-files/Pass%20Mark%20from%202020%20Examinations.pdf
https://actuariesindia.org/sites/default/files/inline-files/Pass%20Mark%20from%202020%20Examinations.pdf
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i. Casio FX-82 MS / SOLAR / SX Plus / ES (with or without any suffix) 
ii. Casio FX-83 (ES/MS) (with or without any suffix) 
iii. Casio FX-85 (ES/MS) (with or without any suffix) 
iv. Casio FX-220 Plus 
v. Casio FX-350 MS 
vi. Casio FX-570 MS 
vii. Canon F-502 G 
viii. Canon F-715 S / SG 
ix. Canon F-720i 
x. HP 10s+ 
xi. Sharp EL-501 X 
xii. Sharp EL-503 W 
xiii. Sharp EL-506 X / W 
xiv. Sharp EL-509 X / W 
xv. Sharp EL-510 RN TI-30XS Multiview 
xvi. Sharp EL-520 X / W 
xvii. Sharp EL-531 XH / XG / WH (with or without any suffix) 
xviii. TI-30X IIS / IIB 
xix. TI-30 eco RS / Xa 
xx. TI-36X II 
xxi. Texas Instruments BA II Plus (with or without any suffix) 
xxii. Texas Instruments TI - 30 Plus (with or without any suffix) 
xxiii. Hewlett Packard HP12c (with or without any suffix) 

 Please note that you will not be allowed to use any other model of the calculator.  

 You may be asked to show and validate the same to the proctor during the examination. 

16. How long does it take to become an Actuary? Does one need to complete the 
exams within a certain time frame? 
There is no fixed duration to complete the course as you are at liberty to take the 

examinations at a pace that suits your circumstances. 13 subjects are prescribed to be 

cleared before one is awarded the Fellowship and calls for continued and sustained efforts 

to complete the course. Additionally, you need a minimum of three years’ relevant work 

experience to qualify as a Fellow. Keeping the above factors in mind, the typical time-

frame for qualification in recent years has been 5-8 years. 

17. Do I need to work before I qualify? How do I work as an actuary if I have not 
yet qualified? 
In order to qualify, there is a minimum work experience requirement of three years in an 

Actuarial field. Almost all reputable actuarial employers have attractive study programs to 

support your development and growth. These include time off work to study and take the 

examinations, mentoring by senior colleagues as well as financial support. 

Being an actuary is a professional qualification and you are expected to gain relevant work 

experience alongside studies. Typically, if you have passed two to four core technical 

papers, it is advisable to actively begin researching your preferred career options and 

secure an appropriate job. 

18. Where/how can I get a job? 

https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
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A list of potential employers is available on the Institute’s website - Actuarial Employers in 

India 

Career opportunities are regularly advertised in the Actuary India magazine as well posted 

on the Institute’s website from time to time. 

Many reputable employers including consultancies and insurance companies recruit entry 

level actuarial students – typically entry level positions may be open to University 

graduates with no or very few actuarial exam passes.   

A placement cell is functioning within the Institute to provide all guidance and support to 

its members on their first job by facilitating job opportunities with various actuarial 

employers. The cell also help students to understand their skill and training requirements 

based on such opportunities with Companies. The member can register with the Placement 

cell and avail all services related to employment/ change of employment. 

Kindly contact Ms. Binita Rautela at binita@actuariesindia.org / +912262433342. 

19. Can I take a drop/not appear for exams in a particular exam session? 
Yes, you may, but you should keep your IAI membership updated, i.e. active. 

20. What certifications do I get on clearing the various levels? 
Detailed information regarding the same is available at the Institute’s website - Types of 

Membership 

21. What if I fail to appear in either of Paper A/Paper B for subjects CS1, CS2, CM1, 
CM2, CP1 and CP2? 
Result will be Absent for respective subject. 

22. What will be the structure of the question paper? 
For CB1, CB2, CS and CM (Paper A) subjects would comprise of multiple-choice questions 

(MCQs) with 40% weightage. This is done to mitigate challenges that may arise in typing 

complex actuarial notations during the examination session. However, please note that 

the students may still be required to type in some actuarial notation/ formula/ equation 

as required basis the question asked for these subjects. 

All other exams will be subjective in nature.  

23. Are the examination conducted an Open-Book format? 

No, this is a closed book examination. Please be informed that you will be monitored by 

online proctors throughout the Examination and applicable rules governing misconduct 

apply in cases of breach or malpractice.   

 

 

 

 

 

 

https://actuariesindia.org/career-advice
https://actuariesindia.org/career-advice
mailto:binita@actuariesindia.org
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/student
https://actuariesindia.org/student
https://actuariesindia.org/frequently-asked-questions-1
https://actuariesindia.org/frequently-asked-questions-1
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Technical: 

24. How will the Home-Based Online Examinations operate? 

 The examination will be conducted within a secured browser environment where students 

can access the questions as well as medium to provide answers. All answers must be typed 

in.  There will be no provision for submission of handwritten and scanned 

answer scripts.  

 Subjects where R-Studio, MS Word and/or MS Excel software is required can be accessed 

within the platform itself. 

 This secured environment will be invigilated through online live proctors.  

25. What are the minimum software and hardware requirement to appear Actuarial 
Examinations? 

 The minimum inescapable software and hardware requirements to appear for online 

Actuarial Examinations is as enumerated.  

Hardware 

Personal Desktop/ Laptop1 

Web Camera 

Microphone 

Operating System 

Licensed Windows 10 and above 

(NOTE: IOS / MAC BOOK ARE NOT ALLOWED) 

.NET Framework 4.5.1 and above 

Web Browser 

(Any One) 

Google Chrome – Ver. 121.0.6167.185 and above 

(Recommended) 

Firefox -Ver. 121.0.1 and above (Recommended) 

Internet Minimum speed of 1 MBPS and above 

Note: Use of mobile hotspot may lead to unstable internet 

connectivity. 

RAM Minimum 1-2 GB 

Note: Device should have free space of more than 250 MB on the default hard 

drive 

 For following subjects, applicants shall also fulfil the additional requirements as given 

below:  

1. CM1, CM2, CP2:  

a. MS Office (Licensed) - 2010 or above  

Note: Functional Keys, Escape key and right click of the mouse will be disabled 
during the time of examination. 

2. CS1, CS2:  

a. MS Office (Licensed) - 2010 or above  

 
1 No tablet or mobile devices are eligible. 
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b. R version 3.6.1 or higher  

c. R Studio – Version 1.1 or higher for 32 bit operating system  

           Version 1.2 or higher for 64 bit operating system  

d. Packages – base, stats, utils, graphics, fpp, markov chain, forecast, dplyr, readxl, 

psych, corrplot, flexsurv, survival, etc. 

We expect the students to meet the above requirements before the mock test.  

26. What if I do not fulfil the mentioned software and hardware requirements to 
appear for online examination? 

 You are strongly advised to equip yourself with the aforementioned software and hardware 

requirements well prior the actual examination. In the absence of one, you will find 

yourself incapable of accessing the online platform and resultantly lose an attempt. 

27. How to check the system compatibility before registering/appearing online 
examination? 
Click Here to check the system compatibility. 
 

28. What functionalities of MS Office and R can be used during the CS, CM and CP2 
examinations? 

 The minimum software version requirement for MS Office and R based examinations are 

provided earlier in answer to FAQ 25. 

 Please take note of the following: 

• You can use any standard function available in Excel, Word and R (excluding the use 
of Macros). 

• You can use the Equation Editor to construct any actuarial notation/symbol/equation. 
Alternately, you can use any other form of presentation of the same so long as any 
third person can comprehend what is written. 

• You are not permitted to handwrite mathematical equations. This includes the use of 
freehand drawing tools or other hardware such as drawing tablets, which are 
prohibited. 

• You are prohibited to use ‘Dictate’ or any similar function. You are expected to 
complete all examination answers using keyboard entry into the applicable platform as 
outlined. 

• You are requested to delete or disable any customized add-ins within the MS Office 
platform as its use or access is prohibited during the examination session. 

• You are prohibited to use RMarkdown and knitR during the R-based examination. 

 
29. What is the duration of the examination? 

Each paper for Home-Based Online Examination will be set to 3 hours and 15 minutes, 

except CS1B, CS2B, CM1B & CM2B each which will be for 1 hour and 45 minutes.  

 For CS, CM and CP2 (Paper A & B), students are responsible to track the exam timer. You 

will be provided additional 15 minutes for uploading your answer script and the upload 

option will be available on the last question of the respective subject. Any work done inside 

https://tests.mettl.com/v2/pre-test-window/launch-msb/open?key=6peaywod1c&sc=true&eck=ozwteMgSOkBKQsdcuLooCEKfEOQ9Pm5x9OacyLdlzokDWHYFb01RguoQs6+unuyT
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the answer script during additional 15 minutes may lead to loss of attempt or failure in 

uploading the answer script. The last successfully uploaded answer script in exam platform 

shall be considered for evaluation. Reference image is as below: 

 

 

30. Is there any risk of examination misconduct by students while writing 
examinations online? 

 The Institute is conscious of risk of misconduct during online exams taken from home/ 

personal space.  Following steps are therefore incumbent to maintain the integrity of 

actuarial examinations: 

• All examinations will be invigilated through online proctors with access to each 
candidate on real time basis. The proctors will be adequately empowered to take 
corrective and/or preventive steps should any misdemeanour be detected during the 
examination session. 

• It will be mandatory for the candidates to keep the webcam and sound 
card/microphone switched on for the entire duration of the examination session. 

• The candidates are advised to appear from a closed room with no one else being 
present in the same confined space. 

• The candidates will be prohibited from having access to any material offline in physical 
format or online on their personal devices or accessible through internet. 

 
The candidates are reminded that they are governed by Instruction to Examinees and 

the Institute reserves the right to appropriate and proportionate action should any 

misconduct come to its notice during or after the examination session. 
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31. Can I use Actuarial Table during examination? 
You can access your own actuarial tables. The book should not contain any annotation or 

markings whatsoever or any pre-written loose sheets attached to it. You may be asked 

to show and validate the same to the proctor during the examination. (Note: Print or 

xerox copy is not allowed) 

 

32. How we will write the solutions or responses of the questions? 

 Below is the subject wise approach to write the solution 

Subject Approach to Write Solution 

CS & CM (Paper A) 
To type answers question wise in MS Word Document and upload 

in exam platform 

CS (Paper B) 
To copy & paste the R codes and output in MS Word document 

and upload in exam platform 

CM (Paper B) 

Download the Solution Template (Excel) embedded within the 

question and then upload the worked solution template back to 

the exam platform 

CP2 

Download the Solution Template (Excel) embedded within the 

question and then upload the worked solution template back to 

the exam platform 

CP1 & CP3 To type answers in Text Editor within the exam platform 

CB, SP, SA To type answers in Text Editor within the exam platform 

 
Note: For CS, CM and CP2 (Paper A & B), each student is responsible to track the exam 
timer. You will be provided additional 15 minutes for uploading your answer script, the 
upload option will be available on the last question of the respective subject. Any work 
done inside the answer script during that additional 15 minutes might lead to loss of 
attempt or failure in uploading the answer script. The last successfully uploaded answer 
script in exam platform shall be considered for evaluation. 
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33. How to write the solutions or responses to MCQ type questions? 
You can choose the right option(s) available on right hand side of the exam screen. 

 

34. Is there any specific font or size to consider at the time of answering through 
online mode? Can I use bold/ italic and colour font in my answer scripts? 

It is recommended to use default font size. 

35.  Is it permitted to use a device that converts handwritten text into typed text 
automatically? 
No, you are not permitted access to any such device.  You are expected to complete all 

examination answers using keyboard entry into the applicable platform as outlined earlier. 

 
36. Can I appear for online examination through my office laptop? 

 You are strongly advised to use your personal laptop/desktop for online examination. 

Office laptop/desktop may have security/download related restrictions. It is the 

candidate’s personal responsibility to ensure they meet the software and hardware 

requirements as stipulated above so that the online examination platform can operate 

without any hindrance. 

37. What happens if the computer hardware or MS Office/R software fails during 
the examination? 

 You are strongly advised to test the hardware i.e. laptop or desktop along with accessories 

like mouse, keyboard, webcam, soundcard/microphone and satisfy yourselves that they 

are in working condition. You should have downloaded any latest security patches and 

keep your device updated to its latest expected version before the start of the examination. 

You can also access any back-up device which meets the minimum hardware requirement 

as a replacement if need arises.  

 In case of MS Office/R, we strongly advise the candidate to only use authorized and 

legitimate version of the software. The candidate is advised to download and install all 

latest software updates before the examination.  

 Given this is home-based examination, it remains the responsibility of the candidate to 

ensure the hardware/software works during the time of examination. 

 During Examinations if you face any technical issue, kindly contact the helpline 

number available on the Examination platform +91 80471 90902/ email the 

issue on  mettl-support@mercer.com keeping copy to 

mailto:mettl-support@mercer.com
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exam@actuariesindia.org. In case you are not able to reach the helpline 

number, kindly contact Institute immediately at 91 22 62433334/36/38 or +91 

8329321986/ 8080225226/ 8655028028.  

38. What happens in case of power failure/interruption during the examination? 

 You are advised to keep your laptop fully charged and/or have a battery capacity that can 

last the full duration of an examination session. For desktop, it is advisable to have power 

back-ups for situations of power failure/interruption.  

 Given this is home-based examination, it remains the responsibility of the candidate to 

ensure the access to uninterrupted power supply to the laptop/ desktop or means to keep 

your device working.  

39. What happens in case if internet connectively fails during the examination? 

The exam is conducted in home based online format, which calls for uninterrupted internal 

connectivity during the examination session. 

 In unforeseen circumstances affecting internet connectivity, the following is to be borne 

in mind: 

• Your work on the text editor within the examination platform gets auto-saved 
frequently and chances of losing any written work are remote. 

• Your work done on MS Office or R software doesn’t get automatically saved in the 
platform until you upload the relevant files at the end.  You should therefore ensure 
you are saving the work in your local drive periodically till it is ready for upload to avoid 
disappointment. 

• You are expected to keep screenshots as evidence for any internet disruption 
impacting your work materially as and when they occur. You may be called upon to 
submit the proofs if any relief is sought citing such disruption. 

• Any deliberate attempt to disconnect the internet access will be considered as 
misconduct and disciplinary action as deemed appropriate can be initiated under such 
circumstances.  

 You are advised to make a provision for alternate internet connection to minimize the risk 

of disruption. 

 

mailto:exam@actuariesindia.org
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40. Is there a way I can apply for mitigating circumstances in case of prolonged 
disruption caused by hardware/software failure, or issues related to electricity 
or internet connectivity? 

Click Here for mitigation policy and procedure. 

41. What happens if the examination platform fails during the examination? 

 In an unfortunate situation where the examination platform fails for reasons other than 

issues related to candidate’s hardware/software or power/internet connectivity, the 

Institute will try to put alternate arrangements in place on a best effort basis. In case it is 

not possible, the Institute may offer to re-schedule to an alternate date or cancel the 

session/provide refund of examination fees as deemed appropriate. 

  

42. Where should I take the examination? 

 We would suggest that you appear for the examination in any place at home, or any 

private place, keeping the following in mind: 

• The place should be quiet and provide you uninterrupted access for the full duration 
of the examination. 

• It should be a confined private place with controlled access for any second person. 
• You are to ensure that no one else is present at any time during the examination 

session 
• You have uninterrupted access to power supply and internet connection. 
• The place should be well lit for the online proctor to monitor the proceeding effectively. 
• You are advised to have a comfortable chair and desk. 

 
43. What can I keep with myself during the examination?  

 The following are permitted during the examination session: 

• One Personal device i.e. laptop/desktop with webcam along with other accessories like 
keyboard, mouse, laptop charger etc. as per the requirement as mentioned under point 
3 above 

• Actuarial tables 

• Scientific calculator 
• Loose sheets of blank paper for rough work. You are required to show these before 

using by the proctor. 
• Pen/Pencil to write on loose sheets 

• Any government-issued ID to be used for verification 
• Transparent Bottle/glass of water 
• Back-up hardware  
Any form of personal consumables, mobile phone, smart watch, handsfree 

device, headset/ earphones etc. or any other electronic gadget are not allowed 

to be kept near you during the examination. 

 

44. What if Government approved ID card and hall ticket are not available with me 
at the time of Examination? 

 You will not be allowed to appear for examination and will lose the attempt. 

 

https://actuariesindia.org/sites/default/files/2023-09/Mitigating%20Circumstance%20Policy%20and%20Procedure.pdf
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45. Can I request for a change to my examination start time? 

 No, the examinations will be strictly held as per the Exam Time Table. 

46. Can I appear for online examination from outside India? 

 All exams are scheduled in Indian Standard Time (IST) 

Click Here to view Announcement of Actuarial Examination 

47. When will I receive the Examination login credentials and Exam Instructions? 

 You will receive the login credentials and exam instructions 2 days before the exam date. 

Exam link and instructions will be made available under your member login a day before 

the exam date. 

48. Is there a Policy for Differently Abled Candidates related to the Examination? 

Yes, we have a policy on this matter. Kindly refer the below link: Click here for details. 

49. Will I be able to login and take the examination after the start time? 

Candidates who log in late after the start time of the examination will not be allowed to 

access the platform and write the examination.  

50. I am unable to install Mettl Secure Browser in my system. How to trouble shoot 
issue while launching MSB during exam? 
You are advised to go through below link: 
https://support.mettl.com/portal/en/kb/induslynk-training-services-p-
ltd/candidates/troubleshooting/during-test 
 

51. How do I check my web camera and microphone compatibility before appearing 
actual examination? 
You are advised to go through below link. 
https://support.mettl.com/portal/en/kb/articles/camera-microphone-issues 

52. How to re-login after facing the technical issue? 
Click on power button located on bottom right side of the screen. Re-login using the same 
examination link after 5-7 minutes. 

 
53. What if my login window keeps loading and not proceeding further? 

Please try the following. 
• Check Internet Connectivity or Exit Browser (click on power button on bottom right of 

exam screen) 
• Uninstall the MSB and re-install the same and try to launch examination again. 
• Hard Shutdown (shut down your system by pressing power button for 5-10 seconds) 
 

54. How to access "R Studio" for CS Paper B Subjects during examination? 
Candidate needs to install the below mentioned software’s in their system in the Local 
Drive C:\Program Files\ 

 
• R version 3.6.1 or higher  
• R Studio – Version 1.1 or higher for 32-bit operating system Version 1.2 or higher for 

64-bit operating system  
 

https://www.actuariesindia.org/examination_dates_examination
https://actuariesindia.org/sites/default/files/2022-08/PolicyforPHCandidates1.pdf
https://support.mettl.com/portal/en/kb/induslynk-training-services-p-ltd/candidates/troubleshooting/during-test
https://support.mettl.com/portal/en/kb/induslynk-training-services-p-ltd/candidates/troubleshooting/during-test
https://support.mettl.com/portal/en/kb/articles/camera-microphone-issues
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R Studio must be installed in following path:  C:\Program Files (i.e. default windows drive).  
If the Secure Exam Browser is unable to locate the R Studio, you can manually locate the 
“R Studio.exe” by browsing to the saved location. 
 

 
 

55. How can I copy/paste codes and output from R Studio to MS Word? 
Type the codes and Output in “R Studio” and simply copy the content using Ctrl + C and 

to paste using Ctrl + V in MS Word document. In case Ctrl + V is not responding, try 

pasting by clicking the Paste → Paste Special → Values option under Home tab within 

the Command Bar in MS Word application. 

 

56. How to access "Excel" or "Word" application during examination? 
Candidate needs to have licensed version of MS Office 2010 and above installed in their 
system in the Local Drive C:\Program Files\ 
 
Mettl Secure Browser will automatically detect the above application and the same can be 
accessed from the task bar below within the examination window. 
 
Note:  
• Candidates are advised to update the following settings in the MS Word and MS Excel 

before      
starting the examination: Open Any Word/Excel document available in your system 
then go to Files → Options → Trust Center → Trust Center Settings → 
Protected View → (Uncheck all the 3 options) → Click on OK. 

• Candidate are required to close all the MS Office applications at the background before 
the examination. 

 
57. How to toggle between the Examination Window and MS Word/Excel during 

the examination? 
You can simply use ALT+TAB to toggle between the Examination Window and MS Word/ 
MS Excel/ RStudio during the examination. This will work only after you have opened at 
least one more application other than main examination platform in MSB. You can also 
toggle by manually selecting the application from the task bar. 

       Note: This is only applicable for CS1, CS2, CM1, CM2 and CP2 Subjects 
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58. I am unable to locate the downloaded solution template/data files provided in 
the question paper? (Applicable for CS, CM, CP2 subjects) 

You can access the downloaded solution template/data files using the following steps: 
i. Open a blank excel file from taskbar, click on “File” option. 
ii. Select Open option, browse the location. 
iii. Select all files from the bottom right of the popped-up screen. 
iv. Select the required file and click on “Open”. 
v. If you face file corrupt issue, please follow below steps: 

a) Open a blank excel file from taskbar, click on “File” option. 
b) Go to option > Trust Centre > Trust Centre Settings > Protected View > 

Uncheck all the three options > Click on “Ok”. 

 

 
59. I am unable to use escape key and right click with the mouse/touch pad during 

examination. 
To ensure stringent integrity and security of examination process delivery, the above 
features will not be available. These restrictions would however not hamper your access 
to any permissible action during the examination, particularly which require use of MS 
Excel software. 
 

60. How to insert Equations/Symbols in solution typing area? 
You can insert equation in solution typing area using the equation editor available in the 
exam platform for all subjects except for CS Series, CM Series and CP2 Subject. 
Kindly refer following link - https://support.mettl.com/portal/en/kb/articles/how-to-
attempt-math-and-chemistry-type-questions-in-the-test 
 

61. I am unable to use the popular shortcut function keys like F2, F4, F9 and F11 
during the examination. 
The examination platform restricts the use of any function keys, particularly during the 
examination which require use of MS Excel software. 

https://support.mettl.com/portal/en/kb/articles/how-to-attempt-math-and-chemistry-type-questions-in-the-test
https://support.mettl.com/portal/en/kb/articles/how-to-attempt-math-and-chemistry-type-questions-in-the-test
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These function keys are meant to act as shortcuts to the standard functions in Excel which 
can still be accessed in the usual manner. We have tabulated below the alternate means 
to operate the some of the popular function keys in Excel during the examinations: 

 
62. Will there be questions in CB, CP1, CP3, SP and SA subjects that require graphs 

and diagrams in the solution? 

Our examiners have aligned the question paper pattern where you will not have a 
mandatory requirement to use graphs/diagrams to support your answers. 

 
****************************** 

Function 
Key (func + 
<>) 

What it does? Direct approach 

F1 Opens Excel Help 
Click the Help tab to access help 
available in the top right of the screen 

F2 
Moves the insertion point to the 
end of the contents of the active 
cell 

Click the cell itself using mouse/touch 
pad 

F3 
Displays the Paste Name dialog 
box 

Type in the Named range in the cell 
itself  

F4 Cell references Type in “$”at appropriate stage 

F5 Displays the Go To dialog box 
Find Go To option by clicking Find & 
Select under Home tab 

F7 Displays the Spelling dialog box Click Spelling on the Review tab 

F9 Calculates the workbook 
Go to the Formulas tab, in the 
Calculation group, click Calculations 
Options 

F11 
Creates a chart sheet of a 
selected range 

Go to the Insert tab, click the Chart 
that you want to draw 

F12 Brings up the Save As dialog box Click Save Us Under File tab 


